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More code examples? We heard you. 

To access an ever-growing list of hundreds of PSoC code examples, please visit our code examples 
web page. You can also explore the Cypress video training library here. 

This guide provides comprehensive information on how to use the Bootloader Software Development Kit (SDK) to 

develop bootload systems for Cypress PSoC 6 MCU products. A detailed description of the SDK application 

programming interface (API), and build instructions for multiple bootloader code examples, are included. 
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1 Introduction 

This guide gives an overview of bootloader fundamentals, followed by a detailed description of the Cypress 
Bootloader Software Development Kit (SDK) and how to use it with PSoC

®
 6 MCU. 

Multiple development tools are covered, including Cypress PSoC CreatorÊ. PSoC Creator is a free Windows-based 
integrated design environment (IDE) that enables concurrent hardware and firmware design of systems based on 
Cypress PSoC MCUs. For more information on PSoC Creator, click here. 

If you are new to bootloaders in general, basic concepts and design principles are explained in the next section, 
What is a Bootloader? 

If you are familiar with bootloaders and want to see how they are implemented in PSoC 6 MCU, see the sections 
Bootloader SDK Description, How to Use the SDK, and Bootloader Code Examples. For a list of the bootloader code 
examples, see Related Documents. For a complete list of PSoC 6 MCU code examples, click here. 

Note: At this time, UART, I
2
C, SPI, and Bluetooth Low Energy (BLE) over the air (OTA) bootloaders are supported. 

http://www.cypress.com/
http://www.cypress.com/training
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/documentation/code-examples/psoc-6-mcu-code-examples
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2 What Is a Bootloader? 

Bootloaders are a common part of MCU system design. A bootloader makes it possible for a product's firmware to be 
updated in the field. In a typical product, firmware is stored in an MCUôs flash memory. The MCU is mounted on a 
printed circuit board (PCB) and embedded in a product, as Figure 1 shows. 

Figure 1. Bootloader Data Flow Block Diagram 
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At the factory, initial programming of firmware into a product is typically done at PCB assembly time, using the MCUôs 
JTAG or SWD interface. However, these interfaces are not usually available in the field, and therefore are generally 
not used for firmware updates. 

A better way to update firmware in the field is to use an existing connection between the product and the outside 
world. The connection may be a standard communication port such as I

2
C, USB, or UART, a wireless channel such 

as BLE, or it may be a custom protocol. 

2.1 Terms and Definitions 

Figure 1 implies that the productôs embedded firmware must be able to use the communication port for two different 
purposes: normal operation and updating flash. That portion of the embedded firmware that knows how to update the 
flash is called a bootloader, as Figure 2 shows. 

Figure 2. Bootloader System 
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Typically, the system that provides the data to update the flash is called the host, and the system being updated is 
called the target. The host can be an external computer or another MCU on the same PCB as the target. 

The act of transferring data from the host to the target flash is called bootloading, or a bootload operation, or just 
bootload for short. The data that is placed in flash is called the application or firmware image. 

http://www.cypress.com/
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2.2 Using a Bootloader 

The bootloader and the application typically share a 
communication port. The first step in using a 
bootloader is to manipulate the product so that the 
bootloader, and not the application, is executing. This 
can be done in response to an event such as a button 
press or a received command. The application 
detects such an event and responds by transferring 
control to the bootloader. 

Once the bootloader is running, the host can send a 
ñstart bootloadò command over the communication 
channel. If the bootloader sends an ñOKò response, 
bootloading can begin. 

2.3 Basic Bootloader Function Flow 

During bootloading, the host reads the file for the new 
application, parses it into flash write commands, and 
sends those commands to the bootloader. After the 
entire file is received and installed in target flash, the 
bootloader can pass control to the new application. 

A bootloader typically executes first after device 
reset.

1 
It can then perform the following actions: 

Á Check the new applicationôs validity before 
transferring control to that application 

Á Manage the timing to start host communication 

Á Do the bootload / flash update operation 

Á Pass control to the new application 

Figure 3 is a flow diagram that shows how this works. 

2.4 Other Use Cases 

Other more complex bootloading use cases exist. A 
common use case is for an application to be running 
and have some event alert the application that an 
update is available. 

While the application continues to execute its normal 
tasks, it also downloads the new application into a 
temporary location. Once the new application is 
verified, it is copied into the correct location in flash, 
and control is transferred to it. 

Figure 3. Bootloader Function Flow 
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1
 In a typical MCU, several events may cause a device reset, for example device power up or a voltage level on a reset pin. In addition, 
firmware can trigger a reset by writing to a device register. This is known as a ñsoftware resetò, or SRES. Using the SRES feature, an 
application can reset the device, for example in response to an event such as a button press. This effectively transfers control to the 
bootloader, because the bootloader executes first at device reset. 

http://www.cypress.com/
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3 Bootloader SDK Description 

The Cypress Bootloader SDK is an API consisting of a set of callable functions and other elements that enable rapid 
bootloader development. The SDK is shipped as a part of the Cypress Peripheral Driver Library (PDL) 3.0.1. The 
PDL is included as part of PSoC Creator 4.2; it is typically found in C:\Program Files (x86)\Cypress\PDL. The SDK 
may be used by other IDEs as well as PSoC Creator. For more information on the PDL, go to here. 

The SDK consists of the following: 

Á Source code, typically .h and .c files as well as linker scripts, that implements the SDK API 

Á Documentation, i.e., this guide. See also the Bootloader SDK API Reference Manual in the PDL doc folder. 

Á Code examples 

Note: You may modify the Bootloader SDK source code for custom purposes, for example to modify or add 
commands to the host interface protocol (see Appendix B: Host Command/Response Protocol). 

3.1 Bootloader SDK Files 

Table 1 lists the the files in the SDK. 

Note: PSoC 6 MCU has two Arm
®
 CPUs: a Cortex

®
-M4 (CM4) and the Cortex-M0+ (CM0+). Linker script files are 

provided for each CPU, for multiple IDEs. For more information, see AN215656, PSoC 6 MCU Dual-CPU System 
Design. 

Note: Linker script files are provided for GCC, µVision MDK, and IAR Embedded Workbench linkers. Use the 
appropriate linker script for your IDE. 

Table 1. Bootloader SDK Files 

File Description 

cy_bootload.h, .c The bootloader software development kit (SDK) files 

bootload_user.h Contains user-editable #define  statements that control the operation and enabled features in the 

SDK. 

bootload_user.c Contains user functions required by the SDK: 

¶ Five functions that control communications with the bootloader host. These are also called 
ñtransport functionsò. 

¶ Two functions ï ReadData()  and WriteData()  ï that control access to internal or external 

memory 

The functions provided are defaults, and may be modified by the user for specific applications. 

transport_uart.h, .c 
transport_... .h, .c 

Contains bootloader transport functions for the host communication Component being used. These 
functions are typically called by the transport functions in bootload_user.c. 

bootload_common.ld GCC linker script. It is user-editable ï it controls the memory layout and the locations in memory for 
each application, and the code and data for each CPU in each application. This file is included in 
the custom GCC linker scripts described next. This file is common to all applications. 

bootload_cm4.ld, 
bootload_cm0p.ld 

Custom GCC linker scripts. In each application, these files replace the auto-generated linker script 
files. These files locate the code and data sections for each of the CPUs as well as the bootloader 
and other regions. These files include the memory layout described in bootload_common.ld. 

bootload_mdk_common.h 
bootload_mdk_symbols.c 

Similar in function to the GCC and IAR common linker scripts, for MDK. The MDK linker does not 
support includes in .scat files, so these files exist to create the necessary defines. 

These files are user-editable ï they control the memory layout and the locations in memory for each 
application, and the code and data for each CPU in each application. These files are common to all 
applications. 

bootload_cm4.scat, 
bootload_cm0p.scat 

Custom MDK linker scripts. In each application, these files replace the auto-generated linker script 
files. These files locate the code and data sections for each CPU as well as the bootloader and 
other regions. 

bootload_common.icf IAR linker script. It is user-editable ï it controls the memory layout and the locations in memory for 
each application, and the code and data for each CPU in each application. This file is included in 
the custom IAR linker scripts described below. This file is common to all applications. 

http://www.cypress.com/
http://www.cypress.com/documentation/software-and-drivers/peripheral-driver-library-pdl
http://www.cypress.com/an215656
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File Description 

bootload_cm4.icf, 
bootload_cm0p.icf 

Custom IAR linker scripts. In each application, these files replace the auto-generated linker script 
files. These files locate the code and data sections for each CPU as well as the bootloader and 
other regions. These files include the memory layout described in bootload_common.icf. 

 
The files are organized in the PDL bootloader folder as Figure 4 shows: 

Figure 4. Bootloader SDK File Organization 

\ --- bootloader  

    |   cy_bootload.h  

    |   cy_bootload.c  

    |   bootload_user.h  

    |   bootload_user.c  

    |   transport_uart.h  

    |   transport_uart.c  

    |   transport_... .h  transport files for other  

    |   transport_... .c  communication channels  

    \ --- gcc_linker_scripts  

    |       bootload_common.ld  

    |       bootload_cm0p.ld  

    |       bootload_cm4.ld  

    \ --- mdk_linker_scripts  

    |       bootload_mdk_common.h  

    |       bootload_mdk_symbol s.c  

    |       bootload_cm0p.scat  

    |       bootload_cm4.scat  

    \ --- iar_linker_scripts  

            bootload_common.icf  

            bootload_cm0p.icf  

            bootload_cm4.icf  

 

3.1.1  User Cal lback Funct ions  

The Bootloader SDK API functions call back to several user functions. This allows you to customize the following 
bootloading operations: 

Á Host communication, also called transport functions or communication interface functions 

Á Reading and writing deviceôs internal flash as well as other non-volatile memory (NVM), for example external 
flash 

Table 2 lists the required user callback functions. The bootloader code examples show typical code for these 
functions; see Bootloader Code Examples and Related Documents. 

Table 2. User Callback Functions 

Function Description 

For Host Communication. Examples are in transport_xxx.h and .c files 

Cy_Bootload_TransportStart()  Opens and initializes the communication channel 

Cy_Bootload_TransportStop()  Closes the communication channel 

Cy_Bootload_TransportReset()  Re-initializes the channel, typically to bring it back to a known state 

Cy_Bootload_TransportRead()  Receives a packet from the host. See Host Packet Structure. 

Cy_Bootload_TransportWrite()  Sends a packet to the host. See Host Packet Structure. 

For Non-Volatile Memory (NVM) Access. Examples are in bootload_user.c. 

Cy_Bootload_ReadData()  Reads data from the device flash or other NVM 

Cy_Bootload_WriteData()  Writes data to the device flash or other NVM 

 

http://www.cypress.com/
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3.1.2  Linker Scripts  

A system with a bootloader is by definition a system with multiple applications (at least two) in NVM. It is up to the 
user to decide where in NVM each application resides. The Bootloader SDK includes template linker script files (see 
Table 1 on page 4 and Figure 4 on page 5) that you can adapt to your application. The bootloader code examples 
include example linker script files. 

3.2 Bootloading Ecosystem 

Other elements of the bootloading system are not included in the SDK. They are available in PSoC Creator or the 
PDL, and can be used by other IDEs: 

Á Bootloader Host Program (BHP). This is an example of the óhostô shown in Figure 2 on page 2. In PSoC Creator, 
select Tools > Bootloader Host.... to launch this program. For more information, see Appendix A, Bootloader 

Host Program. 

Á CyMCUElfTool is a utility that is provided as part of the PDL. It is called as part of building an application, using 
PSoC Creator or other IDEs, as Figure 5 shows. Its main purpose is to combine core and application image files 
into output files. It is a command line program; its option syntax is documented in the Help command ( - h / 
-- help)  output. 

Á Other drivers ï for communication, flash, etc. ï are in the PDL drivers folder. They are called as needed by the 
Bootloader SDK API functions. 

Figure 5. Application Build and Bootload Process Diagram 
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4 How to Use the SDK 

This section describes the general process for using the Bootloader SDK. At a high level, the steps are: 

1. Determine the Applications in Your System 

2. Locate Applications in Memory 

3. Design the Applications 

4. Build and Program the Applications 

For detailed instructions on how to build the Bootloader SDK code examples, go to How to Build the Bootloader Code 
Examples. 

4.1 Determine the Applications in Your System 

The first step is to decide how many applications are to be in your design, and the purpose of each. How many of the 
applications will have bootloader capability? Figure 6 shows some typical memory maps for multiple applications: 

Á Map A shows a basic case, where Application #0 bootloads application #1. 

Á Map B shows a more complex case. There are three applications. All applications can bootload any other 

application. (In practice, Application #0 is usually not updated.) A data section is located outside all applications. 

Á Map C shows the same case as map B except that one of the applications is located in external non-volatile 

memory (NVM. 

In each of the maps, the bootloader system uses a small amount of flash (typically one row) to store application 
metadata. For information, see Appendix D, Application Metadata. 

Figure 6. Example Memory Maps for Bootloading 
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4.2 Locate Applications in Memory 

The next step is to decide where each application is to be located in flash. There are several factors to consider: 

Á A maximum of 63 applications are supported, depending on the metadata size. For more information on 
Bootloader SDK metadata, see Appendix D, Application Metadata. 

Á An application may have code and data for one or more CPUs, for example CM4 and CM0+ in a PSoC 6 MCU 
device. For more information, see the application note AN215656, PSoC 6 MCU Dual-CPU System Design. 

Á The first application, usually called ñApp0ò, must be located at the beginning of user flash, which in PSoC 6 MCU 
is at address 0x1000 0000, as Figure 6 on page 7 shows. This is the first application to execute after device 
reset.

1
 

Note: Another module, such as a Secure Image module in a secure system, may occupy address 0x1000 0000, 
and App0 may be located elsewhere in flash. For more information, see AN221111, Creating a Secure System. 

Á Any application may incorporate the Bootloader SDK, and thus have bootloader capability; that is, the ability to 
download and install another application, and/or transfer control to another application. In most cases, App0 
should have bootloader capability. 

Á PSoC 6 MCU flash has a read-while-write (RWW) capability across 256-KB regions. That is, the bootloader code 
may execute in one flash region while updating flash in another region. As an example, Figure 6 shows 
applications in different 256-KB regions. 

Note: When writing to flash in non-blocking mode, RWW regions are 512 KB in size. For more information, see 
the PDL flash driver documentation and the device Technical Reference Manual (TRM). 

Á Applications may reside in external memory as well as the deviceôs internal flash, as map C in Figure 6 shows. 

External memory is located in a 128-MB sub-region from 0x1800 0000 to 0x1FFF FFFF. 

Note: When executing out of external memory, the external memory device must be mapped into the PSoC 6 
MCU using the QSPI block in XIP mode. For more information, see the device Technical Reference Manual 
(TRM). 

Á PSoC 6 MCU applications include validation bytes, which are saved in NVM, as part of the application. This 
enables an application to be validated before transferring control to it. 

Note: Depending on the security environment within which the applications exist, an application can be 
structured for simple validation (with checksum or CRC data) as well as authorization (with encrypted signature 
data). The bootloader can either directly implement validation, or call a function in the Flash Boot module to 
check authorization. For more information, see AN221111, Creating a Secure System. 

Á NVM data that may be updated during the normal workflow, for example an events log, should not be part of an 
application, because it makes the application difficult to validate. Instead, designate a region of NVM that is 
outside any applicationôs space and use it for data storage. Figure 6 shows two examples in maps B and C. 

Á Reserve a few rows of flash (usually only one is needed) for application metadata, as Figure 6 shows. 
Application metadata is managed by the Bootloader SDK, and is used by applications to transfer control to 
another application. Application metadata space should be outside any application space. 

4.3 Design the Applications 

Note: This section contains only bootloader-specific instructions. For detailed step-by-step instructions for creating a 
PSoC Creator project, see PSoC Creator Help; AN210781, Getting Started with PSoC 6 MCU with Bluetooth Low 
Energy (BLE) Connectivity; or How to Build the Bootloader Code Examples in this document. 

                                            
1
 The CM0+ CPU executes SROM and other system-level code first at device reset, then transfers control to the application residing at 

0x1000 0000. For more information, see the device Technical Reference Manual (TRM). 

http://www.cypress.com/
http://www.cypress.com/an215656
http://www.cypress.com/an221111
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=resource_meta_type%3A583&f%5b2%5d=field_related_products%3A114026
http://www.cypress.com/an221111
http://www.cypress.com/an210781
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The next step is to design each of the applications identified in the previous steps. Each application is a single PSoC 
Creator (or other IDE) project, independent from any other project. With PSoC Creator, you can have all projects in 
one workspace (.cywrk file), or in separate workspaces as well as in separate locations on your computer. Before 
getting started with PSoC 6 MCU, it is a good idea to develop a plan for workspaces and projects for your overall 
system development needs. 

Do the following for each PSoC Creator project that is to be a bootloader or an installable application: 

1. If the application is to do bootloading, place a communication Component on the project schematic; i.e., the 
TopDesign.cysch file. This Component implements the communication channel to the bootloader host. Connect 
the Component terminals to the appropriate physical pins. 

The Bootloader SDK includes support for many of the communication Components in the PSoC Creator 
Component Catalog, including UART, SPI, I2C, and BLE. Code examples are available for each communication 
Component; see Bootloader Code Examples and Related Documents. 

Note: For compatibility with the default transport files in the SDK, name the Component as UART, I2C, SPI, or 
BLE. 

You can also create a custom communication channel. It must implement the transport functions described in 
User Callback Functions. 

2. Incorporate the Bootloader SDK into the project, as Figure 7 shows. Right-click the project in the Workspace 
Explorer window, and select Build Settings.... In the Build Settings dialog, select Peripheral Driver Library. 

Figure 7. Incorporate Bootloader SDK into a PSoC Creator Project 

 

Check Core if the project is either a bootloader or a downloadable application. A downloadable application may 

need to transfer control to another application; the code to do so is included in the Bootloader SDK core files. 

If the project is a bootloader, also check App type Bootloader, and one of the Communication boxes to select 

the host communication channel type. 

Note: In most cases, only one Communication box is checked. However if you want to have a custom 
communication channel, you can leave all Communication boxes unchecked, or even check multiple boxes. 

Click OK when done. 

http://www.cypress.com/
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3. Generate the project files. Click the project in 
the Workspace Explorer window, and select 
Build > Generate Application. The files 

listed in Table 1 on page 4 are copied and 
added to the project, as Figure 8 shows. 

Note that PSoC 6 MCU has two Arm CPUs: 
CM4 and CM0+. Each CPU has its own 
folder, plus Generic folders and a shared 
files folder. Linker script files to locate the 
code for each CPU, for multiple IDEs, are 
automatically copied and added to the 
project. For more information, see 
AN215656, PSoC 6 MCU Dual-CPU System 
Design. 

Note: Figure 8 shows bootloader files added 
to the CM0p folder. Similar files are also 
added to the CM4 folder, but are not shown. 

4. Edit the files bootload_user.h and 
bootload_user.c. Review the user callback 
functions in bootload_user.c, and edit them 
for any customization that is needed, for 
example, to write and read external memory. 
In many cases the functions can be left 
unchanged. 

Note: The bootload_user.c file that is added 

contains the default code for UART. For 
other communication channels such as I

2
C 

and SPI, edit bootload_user.c as follows: 

Á Change: 
  #include "transport_uart.h"  

to: 
  #include "transport_i2c.h"  

or: 
  #include "transport_spi.h"  

or: 
  #include "transport_ ble .h"  

. 

Á Change five instances of Ƨ5!24ʍ5ÁÒÔƨ to 

Ƨ)ʧ#ʍ)ʧÃƨ,  Ƨ30)ʍ3ÐÉƨ, or ƧCyBLEƨ. 

5. Depending on the compiler you are using, 
edit the appropriate common linker script file, 
to encode the decisions made in Locate 
Applications in Memory. For an example, 
see Section 5.3 Step 9. 

Figure 8. Add Bootloader SDK Files to a Project 

 

http://www.cypress.com/
http://www.cypress.com/an215656
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6. Installed linker script files are by default set up for application #0 (app0). For other applications, edit the files by 
changing the application number. The following example shows edits for app1, for the GCC linker, in 
bootload_cm0p.ld and bootload_cm4.ld: 

/*  

* Bootloader SDK - specific: aliases regions, so the rest of the code does not 

use  

* application - specific memory region names  

*/  

REGION_ALIAS("flash_core0", flash_app 1_core0);  

REGION_ALIAS("flash",       flash_app 1_core1);  

REGION_ALIAS("ram",           ram_app 1_core1);  

 

/* Bootloader SDK - specific: sets App I D */  

__cy_app_id = 1;  

The MDK linker is more complex. The following example shows edits for app1 in bootload_cm0p.scat and 
bootload_cm4.scat: 

; Flash  

#define FLASH_START             CY_APP 1_CORE0_FLASH_ADDR 

#define FLASH_SIZE              CY_APP 1_CORE0_FLASH_LENGTH 

 

; Emulated EEPROM Flash area  

#define EM_EEPROM_START         CY_APP 1_CORE0_EM_EEPROM_ADDR 

#define EM_EEPROM_SIZE          CY_APP 1_CORE0_EM_EEPROM_LENGTH 

 

; External memory  

#define XIP_START               CY_APP 1_CORE0_SMIF_ADDR 

#define XIP_SIZE                CY_APP 1_CORE0_SMIF_LENGTH 

 

; RAM  

#define RAM_START               CY_APP 1_CORE0_RAM_ADDR 

#define RAM_SIZE                CY_APP 1_CORE0_RAM_LENGTH 

And edits for App1 in bootload_mdk_symbols.c: 

__cy_app_core1_start_addr   EQU __cpp(CY_APP 1_CORE1_FLASH_ADDR) 

 

/* Application number (ID) */  

__cy_app_id                 EQU 1 

 

/* CyMCUElfTool uses these to generate an application signature */  

__cy_app_verify_start     EQU __cpp(CY_APP 1_CORE0_FLASH_ADDR) 

__cy_app_verify_length    EQU __cpp(CY_APP 1_CORE0_FLASH_LENGTH +  

                                    CY_APP1_CORE1_FLASH_LENGTH -   

                                    __CY_BOOT_SIGNATURE_SIZE) 

http://www.cypress.com/
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7. Change the Project Build settings to use the bootloader linker script files instead of the default linker script files. 
Select the bootload_cm0p.ld file for the CM0+ CPU, as Figure 9 shows. Include the relative path to the file. 
Select the bootload_cm4.ld file for the CM4 CPU (not shown in Figure 9). 

Note: Linker script files are provided for GCC, µVision MDK, and IAR Embedded Workbench linkers. The 
example shown is for GCC. Use the appropriate linker script for your IDE. 

Note: This operation should be done for both Debug and Release configurations. 

Figure 9. Project Build Settings for Custom Linker Scripts 
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8. For updateable application projects, add a post-build batch file to call the Cypress utility program 
cymcuelftool.exe. cymcuelftool is included with your PSoC Creator installation. It generates a *.cyacd2 file, which 

is downloaded by the bootloader host (see Figure 5 on page 6). The batch file is applied only to the CM4 binary. 

Note: See a Bootloader SDK code example such as CE213903, PSoC 6 MCU Basic Bootloaders, for an 
example of a batch file. It is usually found in folder CE213903\Bootloader_Basic_App1.cydsn. The batch file 
contents are also available in Appendix E. For convenience, copy and paste the file into your PSoC Creator 
project folder app1.cydsn. 

Then in PSoC Creator, in the Workspace Explorer window, add the batch file to the projectôs Shared Files folder, 
and add that file as a post-build command to the Cortex-M4 build, as Figure 10 shows. 

Note: This operation must be done for both Debug and Release configurations. 

Figure 10. Post-Build Command 

  

Add code as needed to the two main_cmx.c and other source files. In your overall design, consider the following: 

Á Which bootloader function(s) to call: 

Ğ Cy_Bootload_DoBootload() : blocks while doing the entire bootload operation. Call this function if there 

is no other task to do while bootloading. 

Ğ Cy_Bootload_Init()  followed by a series of calls to Cy_Bootload_Continue() : 

Cy_Bootload_Continue()  blocks while receiving, processing, and responding to one command packet 

from the host. Call these functions if other tasks must be done while bootloading. 

Á When each application shall pass control to another application. Add calls to Bootloader SDK API functions 
ValidateApplication()  and ExecuteApplication()  as needed. 

For more information, see the PDL Bootloader documentation. 

Note: You can copy and paste code from the code examples listed in Bootloader Code Examples and Related 
Documents. 

http://www.cypress.com/
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4.4 Build and Program the Applications 

Build all of the applications. Several output files are created (see also Figure 5 on page 6): 

Á A .hex file for application #0 (App0). Use the .hex file for factory programming. 

Note: Using cymcuelftool, it is possible to create a .hex file that incorporates multiple applications, for example 
App0 and App1, for factory programming. 

Á A .cyacd2 file for each installable application (see Step 8 in the previous section). Use these files for field 

updates, that is, for bootloading. 

Program the .hex file into the device, using either PSoC Creator or PSoC Programmer. For more information on 
device programming, see the Help menus in these tools. 

At a later time, you can use the bootloader in application #0, along with a bootloader host program, to download and 
install application .cyacd2 files into the device. See Appendix A, Bootloader Host Program. 
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5 Bootloader Code Examples 

There are several code examples associated with this application note. They demonstrate the different ways that 
bootloading can be done. 

A complete list of code examples and other documents, with download links on www.cypress.com, is available in 
Related Documents. 

Table 3 shows an overview-level list of the code examples: 

Table 3. List of Bootloader Code Examples 

CE # Title Description 

CE213903 PSoC 6 MCU Basic Bootloaders A set of examples that demonstrate several basic bootloading operations; 
see Figure 6 on page 7, memory map A: 

¶ Downloading an application from a host, using various PSoC Creator 
Components for host communication: UART, I2C, and SPI 

¶ Installing the downloaded application into user flash 

¶ Validating an application, and then transferring control to that 
application 

CE216767 PSoC 6 MCU with Bluetooth Low 
Energy (BLE) Connectivity 
Bootloader 

Same as CE213903, but uses BLE as the communication channel 

CE220959 PSoC 6 MCU BLE Bootloader 
with External Memory 

Same as CE216767, but saves the application temporarily in external 
memory, then copies it to its final destination in user flash 

CE221984 PSoC 6 MCU Dual-Application 
Bootloader 

Same as CE213903, but demonstrates bootloading two applications, with 
a factory default (ñgolden imageò) mode. 

The following code examples are planned or in development: 

CE220960 PSoC 6 MCU BLE Bootloader 
with Upgradeable Stack 

Same as CE216767, plus the BLE stack can be upgraded 

CE222802 Bootloader with Encryption and 
Signing 

Same as CE213903, but the application is encrypted and signed for 
validation. The bootloader decrypts the application and validates its 
signature. 

CE2xxxxx USB HID Bootloader Same as CE231903, but uses USB HID as the communication channel 

CE2xxxxx USB Mass Storage Bootloader Same as CE231903, but uses USB Mass Storage as the communication 
channel 

CE2xxxxx Bootloader with Multiple 
Applications 

Bootloads multiple applications; see Figure 6 on page 7, memory map B. 
Each application can bootload another application. 

CE2xxxxx PSoC 6 MCU Bootloader with 
External Memory Source 

Same as CE213903, but the bootload source is external memory 

CE2xxxxx Embedded Host Program Similar to that described in AN60317, PSoC® 3 and PSoC 5LP I
2
C 

Bootloader 

 
Most of the code examples consist of multiple separate applications, called ñApp0ò and ñApp1ò. In some cases 
additional applications, called ñApp2ò, ñApp3ò, and so on, are included. Each application is a separate project in PSoC 
Creator. 

Generally, all applications are in the same PSoC Creator workspace. As noted in Design the Applications, projects 
can exist in separate workspaces as well as in separate locations on your computer. 

Usually App0 does the bootloading; it downloads and installs the other applications. 

The basic code example, CE213903, has multiple '_App0_ ... ' projects; each project has a different communication 
channel. Advanced communication channels such as BLE and USB are demonstrated in other code examples. 

Note: At this time, UART, I
2
C, SPI, and BLE are supported. 

The code examples support the CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit. Applications typically blink a kit LED at 
different rates or in different colors, making it easy to tell which application is currently running. 

http://www.cypress.com/
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In general, the applications are designed such that you can transfer control from one application to another, by 
holding a kit button down for 0.5 second. The BLE bootloader code examples use the Immediate Alert Service (IAS) 
to transfer control between applications. 

5.1 How to Build the Bootloader Code Examples 

The following are step-by-step instructions showing how to build each bootloader code example listed in Table 3 on 
page 15, with optional adaptations for your application. For more information, see How to Use the SDK. 

The instructions are based on PSoC Creator; they can be adapted for other IDEs. 

5.2 PSoC 6 MCU Basic Bootloaders 

This section shows how to build the basic bootloaders in code example CE213903. There are five general steps: 

1. Create App0 and the workspace. 

2. Configure App0 as a bootloader. 

3. Add App1. 

4. Configure App1 as an installable application. 

5. Build and test the bootloader and the application. 

1. Create App0 and the workspace. 

You can create a PSoC Creator project and its containing workspace at the same time. In PSoC Creator, select 
File > New > Project.... The Create Project, Select project type window appears, as Figure 11 shows. 

A. Click Target device. 

B. In the first drop-down menu, select PSoC 6. 

C. In the next drop-down menu, select CY8C6347BZI-BLD53. This is the PSoC 6 MCU device that is installed 

in the CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit. 

D. Click Next. 

Figure 11. Select the Target Device 

A

B C

D

 

http://www.cypress.com/
http://www.cypress.com/ce213903
http://www.cypress.com/cy8ckit-062-ble


 

PSoC 6 MCU Bootloader Software Development Kit (SDK) Guide 

www.cypress.com Document No. 002-13924 Rev. *D 17 

Click Next on the next two panels, Select project template and Set target IDE(s). The Create Project panel 

appears, as Figure 12 shows. 

Enter the Workspace name, and select its Location. Set Project name to ñapp0ò. Click Finish. 

A new folder is created in the indicated location; the folder name is the same as the workspace name. A folder 
app0.cydsn is created within the workspace folder; the .cydsn folder contains all project files. 

Figure 12. Create the Project 

 

The new workspace and project files are shown in the Workspace Explorer window; see Figure 8 on page 10. 
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2. Configure App0 as a bootloader. 

To add bootloader capability to an application, you must: 

Á Add a communication Component to the project schematic. Use this Component to communicate with your 
bootloader host. 

Á Add other Components to the project schematic as needed for your application 

Á Add Bootloader SDK and template files to the project 

2a.  Add a communication Component. Open or double-click the project schematic (file TopDesign.cysch in 

the Workspace Explorer window). 

Open the Component Catalog, and navigate to your desired communication Component, for example UART, as 
Figure 13 shows. Drag the Component onto the schematic. 

Figure 13. Add a Communication Component to a Bootloader Project 

 

  

http://www.cypress.com/


 

PSoC 6 MCU Bootloader Software Development Kit (SDK) Guide 

www.cypress.com Document No. 002-13924 Rev. *D 19 

Double-click the Component on the schematic to configure its parameters, such as baud rate, number of bits, 
etc., as Figure 14 shows. 

Figure 14 shows the changed parameter settings for this code example; note that Name is changed from 

UART_1 to UART, I2C_1 to I2C, or SPI_1 to SPI. This is recommended to work with the default Bootloader SDK 
files that are copied to your project later. 

When done configuring the Component, click OK. 

Figure 14. Configure the Communication Component: UART, I2C, or SPI 

    

 

2b.  Add other Components. Add other PSoC Creator Components such as LED and button pins to the project 

schematic. The easiest way to do this is to copy and paste portions of the project schematic from the code 
example CE213903, and then modify the schematic as needed for your application. 

In the Design Wide Resources window, Pins tab, connect the UART, I2C, SPI and other Component pins to the 

appropriate physical pins. Use CE213903 and the guide for your kit for guidance. 

http://www.cypress.com/
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2c.  Add bootloader code to the project. First, incorporate the Bootloader SDK into the project ï see Figure 7 

on page 9. 

Then select Build > Generate Application. When done, the project should look like Figure 8 on page 10, with 

the addition of some startup and other non-bootloader files. 

For I
2
C and SPI bootloaders, edit the file bootload_user.c, in the project Shared Files folder, as follows: 

¶ Change  #include  "transport_ uart .h"   to 

#include "transport_i2c.h"   or   

#include  "transport_ spi .h" . 

¶ Change five instances of Ƨ5!24ʍ5ÁÒÔƨ to Ƨ)ʧ#ʍ)ʧÃƨ ÏÒ Ƨ30)ʍ3ÐÉƨ. 

Add bootloader code to the main_cm0p.c and main_cm4.c files. The easiest way to do this is to copy and paste 
the code from the code example CE213903, and then modify the code for your application.  

2d. Build the project. Change the project build settings to use the template linker script files; see Figure 9 on 
page 12. Then select Build > Build app0. 

3. Add App1. 

As noted previously, with PSoC Creator, you can add other projects ï applications ï to the same workspace as 
the bootloader application, or they can be in separate workspaces and/or folders. These instructions show how to 
add App1 to the same workspace as the bootloader App0. 

Note: You can create any number of installable applications that work with the same bootloader. Before getting 
started with developing applications, it is a good idea to develop a plan for bootloader and applications for your 
overall system development needs. See Determine the Applications in Your System. 

In the PSoC Creator Workspace Explorer window, right-click the Workspace, then select Add > New Project..., 

as Figure 15 shows: 

Figure 15. Add a New Project to a PSoC Creator Workspace 

 

The Create Project, Select project type window appears; see Figure 11 on page 16. Make sure that the device 
selected is the same as for App0. Click Next. 

Click Next on the next two panels: Select project template and Set target IDE(s). The Create Project panel 

appears. 

http://www.cypress.com/
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Set Project name to ñapp1ò, as Figure 16 shows. The default Location is the workspace folder. Click Finish. 

A new app1.cydsn folder is created within the workspace folder; the .cydsn folder contains all project files. 

Figure 16. Create a Second Project 

 

4. Configure App1 as an installable application. 

Note: App1 should be built with the same toolchain (GCC or MDK) as App0, or application transfer may fail. 

4a.  Add other Components such as LED and button pins to the project schematic. The easiest way to do 

this is to copy and paste portions of the project schematic from the code example CE213903, and then modify 
the schematic for your application. 

In the Design Wide Resources window, Pins tab, connect the Component pins to the appropriate physical pins. 

Use CE213903 and the guide for your kit for guidance. 

4b.  Add Bootloader SDK and template files to the project. Incorporate the Bootloader SDK into the project; 
see Figure 7 on page 9. Check only the Core box, because App1 is a downloadable application and does not 

have bootloader capabilities. 

Then, select Build > Generate Application. When done, the project should look like Figure 8 on page 10, with 

the addition of some startup and other non-bootloader files. Change the project build settings to use the template 
linker script files; see Figure 9 on page 12. 

Add a post-build batch file to the Shared Files folder, as described in Section 4.3 Step 8. Then add a post-build 
command to the Cortex-M4 build ï see Figure 10 on page 13. 

4c.  Edit files. Edit the linker script files as described in Section 4.3 Step 6. 

Add bootloader code to the main_cm0p.c and main_cm4.c files. The easiest way to do this is to copy and paste 
the code from the code example CE213903, and then modify the code for your application. 

4d. Build the project. After all build setting changes and file edits are complete, select Build > Build app1. 

http://www.cypress.com/
http://www.cypress.com/ce213903
http://www.cypress.com/ce213903


 

PSoC 6 MCU Bootloader Software Development Kit (SDK) Guide 

www.cypress.com Document No. 002-13924 Rev. *D 22 

5. Test the bootloader and applications. 

Program app0 into a CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit. Then use the Bootloader Host Program (BHP) 
to bootload app1 to the kit; see BHP usage instructions in Appendix A. 

You can test the bootloader and applications using the instructions in the CE213903 document, Operation 
section. 

5.3 PSoC 6 MCU BLE Bootloaders 

This section shows how to build two different BLE bootloaders, in code examples CE216767, PSoC 6 MCU with 
Bluetooth Low Energy (BLE) Connectivity Bootloader, and CE220959, BLE Bootloader with External Memory. These 
code examples are similar to the basic bootloaders code example, with some additional features: 

Á CE216767 downloads a new application 
directly into flash, as Figure 17 shows. 

Á CE220959 downloads a new application into 
temporary storage in an external NVM (kit IC 
U4, Cypress 512-Mbit serial NOR flash), and 
then copies it to its final destination in the 
PSoC 6 MCU device flash, as Figure 18 
shows. 

Á The bootloader (App0) and the application 
(App1) each have their own separate copy of 
the BLE stack code, as Figure 17 and Figure 
18 show. Each copy occupies more than 
128 KB of flash. A future Bootloader SDK 
code example will show a single shared BLE 
stack. 

Figure 17. Data and Control Flow for CE216767 
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Figure 18. Data and Control Flow for CE220959 
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Á The BLE stack code can be executed by either CPU or by both CPUs; this is a selectable option in the BLE 
Component configuration dialog. Both code examples demonstrate this feature; in App0 the CM4 CPU executes 
the BLE stack, in App1 the CM0+ CPU executes the BLE stack. 

Á App0 and App1 enable different services in their BLE Component configurations: 

Ğ App0: Bootloader and Immediate Alert Service (IAS). The IAS service is implemented when the application is 
not bootloading. 

Ğ App1: Human Interface Device (HID) and Immediate Alert Service (IAS) 

 

Both applications use the IAS to transfer control from one application to the other. 

Á Both code examples make extensive use of CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit resources.  All three 
RGB LEDs, the user button SW2, the BLE subsystem, and the USB-UART bridge are all used by both 
applications (App0 and App1). 
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To build either of the code examples, do the following. For more information on these steps, refer to PSoC 6 MCU 
Basic Bootloaders or How to Use the SDK. 

1. Create App0 and the workspace, as Figure 19 shows. 

Figure 19. Create BLE Bootloader App0 

 

2. Add a BLE Component to the App0 Top Design schematic, and configure the Component according to the 
BLE Component Configuration section in either code example. Specifically, make the following changes from the 
default configuration: 

Á (optional, but recommended to work with default Bootloader SDK files) Change the Component name to 

óBLEô. 

Á General tab (see Figure 20): CPU core: Single core (Complete Component on CM4) 

Figure 20. BLE Component, General Tab Configuration 
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Á GATT Settings tab (see Figure 21): 

Ğ Generic Access, Peripheral Preferred Connection Parameters: 

Ğ Minimum Connection Interval: 0x000C 

Ğ Maximum Connection Interval: 0x000C 

Ğ Connection Supervision Timeout Multiplier: 0x00C8 

These intervals are selected to minimize the bootloading time. Adjust as needed for your application. 

Ğ Right-click the Server node in the GATT tree, and add the Bootloader service. Optionally, add the 

Immediate Alert service; the code examples use this service to transfer control between applications. 

There is no need to edit either serviceôs characteristics. 

Ğ Attribute MTU size (bytes): 512 

Figure 21. BLE Component, GATT Settings Tab Configuration 
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Á GAP Settings tab: 

Ğ Device Name: The code examples use ñBLE Bootloaderò; use different text as needed for your 

application. 

Ğ Peripheral Configuration 0, Advertisement packet: Local Name checked and set to Complete. 

Ğ Security configuration 0 (see Figure 22), Security level: Unauthenticated pairing with encryption. 

Ğ Security configuration 0, I/O capabilities: No Input No Output. 

Ğ Security configuration 0, Bonding requirement: No Bonding. 

Figure 22. BLE Component, GAP Settings Tab Configuration 

 

Á Link Layer Settings tab: 

Ğ Link layer max TX and RX payload size (bytes): 251, for faster bootloading 

3. For CE220959, add an SMIF Component to the App0 schematic, and configure the Component according to the 
SMIF Component Configuration section. Specifically, make the following changes from the default configuration: 

Á (optional, but recommended to work with CE220959 files) Name: SMIF 

Á Check SMIF Datalines [2:3]. The external memory IC has a quad-SPI (4 data lines) interface with the 

PSoC 6 MCU device. The SMIF Datalines [0:1] box is checked as a default. 

Á Uncheck Generate code from cy_smif.cysmif file. Files cy_smif_memconfig.h/.c and smif_mem.h/.c are 

already provided with the code example. 

4. As needed, copy other Components ï i.e., LEDs and button ï from either the CE216767 or CE220959 top 
design schematic to your top design schematic. 

5. In the Design Wide Resources window: 

Á Pins tab: Connect the Component pins to the appropriate physical pins. Note that the BLE Component does 

not use any pins. 

Á Clocks tab: Set the FLL frequency to 50 MHz. Enable the WCO, and source Clk_LF and Clk_Bak from 

WCO. For CE220959, enable Clk_HF2 and source it from Path 0 (50 MHz). 

http://www.cypress.com/
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6. Configure App0 as a bootloader in the project Build Settings ï see Figure 7 on page 9. Select BLE for the 

communication channel. 

7. Select Build > Generate Application. This creates the bootloader linker files, e.g., bootload_cm4.ld. 

8. Go back to the project Build Settings and set the Custom Linker Script for CM0+ and CM4 to the respective 

bootloader linker script files ï see Figure 9 on page 12. 

9. Edit the flash and RAM memory region sizes in bootload_common.ld, as follows: 

MEMORY 

{  

    flash_app0_core0  (rx)  : ORIGIN = 0x10000000, LENGTH = 0x10000  

    flash_app0_core1  (rx)  : ORIGIN = 0x10010000, LENGTH = 0x30000  

    flash_app1_core0  (rx)  : ORIGIN = 0x10040000, LENGTH = 0x32000  

    flash_app1_core1  (rx)  : ORIGIN = 0x10072000,  LENGTH = 0x02000  

. . .  

    ram_app0_core0    (rwx) : ORIGIN = 0x08000100, LENGTH = 0x1F00  

    ram_app0_core1    (rwx) : ORIGIN = 0x08002000, LENGTH = 0x8000  

. . .  

    ram_app1_core0    (rwx) : ORIGIN = 0x08000100, LENGTH = 0x1FF00  

    ram_app1_core1    (r wx) : ORIGIN = 0x08020000, LENGTH = 0x20000  

. . .  

The default bootload_common.ld allocates an equal amount of flash and RAM to each CPU in each application. 
The allocations must be adjusted for these code examples because: 

Á The BLE stack size is large 

Á App1 size should be minimized to reduce bootloading time 

Note that the same changes are done for App1 in the code examples. Similar memory layouts exist for the MDK 
and IAR linker scripts. 
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10. Copy and paste files debug.h/.c, ias.h/.c, and 

bootload_user.h/.c from your CE216767 or 

CE220959 folder to your app0.cydsn folder. 

Overwrite the existing default bootload_user.h/.c 

files. In addition, for CE220959, copy and paste 

cy_smif_memconfig.h/.c and smif_mem.h/.c files. 

Á The debug and ias (Immediate Alert Service) 
files are unique to the code examples, and may 
be optional for your application. 

Á The bootload_user files have already been 
edited to call the BLE transport functions instead 
of the default UART transport functions. 

Á For CE220959, the SMIF files define the 
external memory configuration and provide 
functions to access external memory. 

11. In the PSoC Creator Workspace Explorer window, 
include or move the files from the previous step to 
the project CM4 Header Files and Source Files 
folders, as Figure 23 shows. 

If these files are in the Shared Files folder, they may 
be included in the CM0+ build and compile errors 
may result. 

12. Copy CM0+ and CM4 main code from CE216767 or 
CE220959 to your main files. Update the main and 
other source files as needed for your application. 

13. Build app0, and program the kit with app0. 

You can test your app0 by installing app1 from 
CE216767 or CE220959. Follow the instructions in 
the code example document, Operation section. 

Figure 23. Source Files Included in CM4 Folders 

 

14. If you build your own app1, remember to edit the following files: 

Á Three linker script files as described in Step 9 and in Section 4.3 Step 6. 

Á The batch file as described in Section 4.3 Step 8. 

5.4 PSoC 6 MCU Dual-Application Bootloader 

This section shows how to build the BLE bootloader in the code example CE221984. This code example is similar to 
the basic bootloaders code example, except that there are two downloadable applications instead of one. There are a 
total of three applications; App0 is the bootloader and App1 and App2 are the downloadable applications. 

The bootloader transfers control to one of the applications in either a basic mode or a factory default (ñgolden imageò) 
mode. In factory default mode, the bootloader (App0) does not overwrite an installed and valid App1; an attempt to do 
so results in an error message. In basic mode, either application can be overwritten. 

In this code example, the bootloader uses an I
2
C communication channel. It is easy to change to a different 

communication channel; for more information, refer to one of the previous sections. 

To build this code example, do the following steps. For more information on these steps, refer to PSoC 6 MCU Basic 
Bootloaders or How to Use the SDK. 
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1. Create App0 and the workspace, as Figure 24 shows. 

Figure 24. Create Dual-Application Bootloader App0 

 

2. Configure App0 as a bootloader in the project Build Settings ï see Figure 7 on page 9. Select I2C for the 

communication channel. 

3. Select Build > Generate Application. This creates the bootloader linker files, e.g., bootload_cm4.ld. 

4. Go back to the project Build Settings and set the Custom Linker Script for CM0+ and CM4 to the respective 

bootloader linker script files ï see Figure 9 on page 12. 

5. Add an I2C Component to the App0 schematic, and configure the Component according to Figure 14 on page 
19. At this time, you can also add the Pin Components used by CE221984; the easiest way to do this is to copy 
and paste the Components from the code example schematic. 

6. In the Design-Wide Resources window, Pins tab, connect the Component pins to the appropriate physical pins. 

7. Update the files listed in Table 4 with the content of the corresponding files in CE221984. Add code as needed 
for your application. 

Table 4. CE221984 App0 Files Modified from the Bootloader SDK Default 

File Description of Modification from the Default 

bootload_common.ld 

bootload_mdk_common.h 

Addition of memory regions for App2 

bootload_user.h Set the CY_BOOTLOAD_GOLDEN_IMAGE_IDS macro to identify App1 as the factory default 

image. 

To change the code example mode, change the CY_BOOTLOAD_OPT_GOLDEN_IMAGE macro 
to a nonzero value. 

bootload_user.c Changed transport functions to I2C from UART. 

Added code to Cy_Bootload_WriteData()  to do the factory default (ñgolden imageò) check. 

main_cm0p.c 

main_cm4.c 

Addition of code to do the code example functions 
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8. Build the app0 project, and program it into the target kit. Test the application download (bootload) process. You 
can use the test steps listed in the Operation section of the CE221984 document. Try changing the 
CY_BOOTLOAD_OPT_GOLDEN_IMAGE macro to a nonzero value, and note the different behavior of the bootloader 

when you download App1. 

You can test the bootloader using the app1 and app2 projects already in the code example, or create your own 
applications, as the following step shows: 

9. Add an app1 project and an app2 project. You can configure both projects as installable applications. The 
detailed steps required are presented in Section 5.2 Step 3 and Step 4. Significant tasks are: 

Á Update the project build settings: 

Ğ Peripheral Driver Library > Bootloader SDK. Check only the Core box. (Figure 7 on page 9.) 

Ğ Linker custom scripts. (Figure 9 on page 12.) 

Ğ Post-build batch file (Figure 10 on page 13.) 

Á Add the post_build_core1.bat file to the project, in the Shared Files folder. See Appendix E for typical batch 

file content. 

Á Update the project schematic and design-wide resources files with the content of the corresponding files in 
CE221984. Modify the design as needed for your application. 

Á Update the files listed in Table 5 with the content of the corresponding files in CE221984. Add code as 
needed for your application. 

Table 5. CE221984 App1 and App2 Files Modified from the Bootloader SDK Default 

File Description of Modification from the Default 

bootload_common.ld 

bootload_mdk_common.h 

Addition of memory regions for App2 

bootload_cmp0.ld 

bootload_cm4.ld 

bootload_cmp0.scat 

bootload_cm4.scat 

Specify the memory regions and App ID as being for app1 or app2 

bootload_user.h Set the CY_BOOTLOAD_GOLDEN_IMAGE_IDS macro to identify App1 as the factory 

default image. To change the code example mode, change the 
CY_BOOTLOAD_OPT_GOLDEN_IMAGE macro to a nonzero value. 

main_cm0p.c 

main_cm4.c 

Addition of code to do the code example functions 
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6 Related Documents 

Application Notes 

AN210781 ï Getting Started with PSoC 6 MCU 
with Bluetooth Low Energy (BLE) Connectivity 

Describes PSoC 6 MCU with BLE Connectivity devices and how to build 
your first PSoC Creator project 

AN215656 ï PSoC 6 MCU: Dual-CPU system 
Design 

Describes the dual-CPU architecture in PSoC 6 MCU, and shows how to 
build a simple dual-CPU design 

AN219434 ï Importing PSoC Creator Code into 
an IDE for a PSoC 6 MCU Project 

Describes how to import the code generated by PSoC Creator into your 
preferred IDE 

Code Examples 

CE213903 ï PSoC 6 MCU Basic Bootloaders 
Describes UART, I

2
C, and SPI bootloaders for PSoC 6 

MCU 

CE216767 ï PSoC 6 MCU with Bluetooth Low Energy (BLE) 
Connectivity Bootloader 

Describes a BLE bootloader for PSoC 6 MCU 

CE220959 ï PSoC 6 MCU BLE Bootloader with External Memory 
Similar to the BLE bootloader; the downloaded 
application is temporarily saved in external memory and 
then copied to its final destination 

CE221984 ï PSoC 6 MCU Dual-Application I2C Bootloader  
Similar to the basic I

2
C bootloader; manages two 

downloaded applications instead of one 

PSoC Creator Component Datasheets 

UART Supports UART-based communications 

I2C Supports I
2
C-based communications 

SPI Supports SPI-based communications 

BLE Supports BLE communications 

Device Documentation 

PSoC 6 MCU: PSoC 63 with BLE Datasheet PSoC 6 MCU: PSoC 63 with BLE Architecture Technical Reference Manual 

Development Kit Documentation 

CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit 
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http://www.cypress.com/documentation/component-datasheets/uart-scbuartpdl
http://www.cypress.com/documentation/component-datasheets/i2c-scbi2cpdl
http://www.cypress.com/documentation/component-datasheets/spi-scbspipdl
http://www.cypress.com/documentation/component-datasheets/bluetooth-low-energy-blepdl
http://www.cypress.com/ds218787
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Appendix A. Bootloader Host Program (BHP) 

The Bootloader Host Program (BHP) is a standalone graphical tool provided with PSoC Creator. This tool is used to 
communicate with a PSoC device that has a bootloader installed. Using the Bootloader Host application, you can: 

Á Download and install an application to a device 

Á Verify an application that is already installed on a device 

Á Erase an application from a device 

Note: You cannot use BHP to install a bootloader into a device. Instead, you must program a bootloader into flash 
through the device SWD/JTAG port, using other tools such as PSoC Creator or PSoC Programmer. After a 
bootloader is installed, you can use BHP to install an application. 

BHP supports communicating with Cypress MCU devices via UART, I
2
C, SPI, or USB, as Figure 25 shows. You can 

see all devices available for connection. For UART or USB, communication can be done directly from your computer 
by connecting an appropriate cable. For I

2
C and SPI, a special communication port is needed, such as a KitProg 

module. The port configuration fields change depending on the selected port. 

Note: At this time, only the UART, I
2
C, and SPI bootloaders are supported for PSoC 6 MCU. 

Note: BHP does not support Bluetooth Low-Energy (BLE). Use Cypressô CySmartÊ product instead; see the 
CySmart User Guide section ñUpdating Peripheral Device Firmwareò. 

Figure 25. Bootloader Host Program Graphical User Interface (GUI) 
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Note: The source code for the BHP is provided in <PSoC Creator install folder>\cybootloaderutils. It contains routines 
to do file parsing and command construction. You can add a GUI and a communication protocol to build your own 
host program. 

To use the BHP, do the following: 

1. Select the communication port that matches the communication Component in your bootloader. See Figure 13 
on page 18. 

2. Click the File icon, or select File > Open, and navigate to your applicationôs .cyacd2 file, as  

Figure 26 shows. This file is created when an application project is built by PSoC Creator; for more information, 
see Build and Program the Applications. 

Figure 26. Select the .cyacd2 File 

 

3. Make sure that the bootloader is running in your target device. Click the BHP Program icon, or select Actions > 
Program. The selected application is downloaded and installed in the target device. Depending on your system-level 

design (see Determine the Applications in Your System), control is transferred from the bootloader to the downloaded 
application. 
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Appendix B. Host Command/Response Protocol 

The bootloader communicates with a host using a simple command-response protocol, regardless of the 
communication channel used. The bootloader receives commands from the communication channel, and responds to 
each command by sending one or more bytes to the communication channel. See Figure 2 on page 2. 

The commands and responses are in the form of a byte stream, packetized in a manner that ensures the integrity of 
the data being transmitted. A packet validity check method is included, and consists of a 2's complement 16-bit 
checksum. 

B.1 Command/Response Packet Structure 

Communication packets sent from the host to the bootloader have the structure shown in Figure 27: 

Figure 27. Bootloader Command Packet Structure 

Start of Packet

(0x01)

Command Data Length (N) N bytes of data Checksum End of Packet

(0x17)

1 Byte 1 Byte 2 Bytes N Bytes 2 Bytes 1 Byte

 

Response packets sent from the Bootloader to the host have the structure shown in Figure 28: 

Figure 28. Bootloader Response Packet Structure 

Start of Packet

(0x01)

Status Code Data Length (N) N bytes of data Checksum End of Packet

(0x17)

1 Byte 1 Byte 2 Bytes N Bytes 2 Bytes 1 Byte

 

All multi-byte fields are LSB first. 

B.2 Commands 

Table 6 shows a list of all commands supported by the Bootloader SDK. All commands except Exit Bootloader are 
ignored until the Enter Bootloader command is received. 

Table 6. Bootloader Commands List  

Bootloader Commands 

Enter/Exit  Bootload Operation Miscellaneous 

Enter Bootloader Send Data Verify Application 

Sync Bootloader Send Data Without Response Set Application Metadata 

Exit Bootloader Program Data Get Metadata 

 Verify Data Set EIVector 

 Erase Data  

 
There is no specific requirement for command execution time. 
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Table 7 shows a list of all status and error codes supported by the Bootloader SDK. 

Table 7. Bootloader Status and Error Codes List 

Status/Error Code Value Description 

CY_BOOTLOAD_SUCCESS 0x00 The command was successfully received and executed 

CY_BOOTLOAD_ERROR_VERIFY 0x02 Verification of non-volatile memory (NVM) after write failed 

CY_BOOTLOAD_ ERROR_LENGTH 0x03 The amount of data sent is greater than expected 

CY_BOOTLOAD_ ERROR_DATA 0x04 Packet data is not of the proper form 

CY_BOOTLOAD_ ERROR_CMD 0x05 The command is not recognized 

CY_BOOTLOAD_ ERROR_CHECKSUM 0x08 Packet checksum or CRC does not match the expected value 

CY_BOOTLOAD_ ERROR_ROW 0x0A The flash row number is not valid 

CY_BOOTLOAD_ ERROR_ROW_ACCESS 0x0B The flash row number cannot be accessed, for example due to 
MPU protection 

CY_BOOTLOAD_ERROR_UNKNOWN 0x0F An unknown error occurred 

 

B.2.1  Enter  Bootloader  

Begins a bootload operation. All other commands except Exit Bootloader are ignored until this command is received. 
Responds with device information and Bootloader SDK version. 

Á Input 

Ğ Command Byte: 0x38 

Ğ Data Bytes: 

Á 4 bytes (optional): product ID. If these bytes are included, and they are not 00 00 00 00, they are 
compared to device product ID data. 

Á Output 

Ğ Status/Error Codes: 

Á Success 

Á Error Command 

Á Error Data, used for product ID mismatch 

Á Error Length 

Á Error Checksum 

Ğ Data Bytes: 

Á 4 bytes: Device JTAG ID 

Á 1 byte: Device revision 

Á 3 bytes: Bootloader SDK version 

B.2.2  Sync Bootloader  

Resets the bootloader to a known state, making it ready to accept a new command. Any data that was buffered is 
discarded. This command is only needed if the bootloader and the host get out of sync with each other. 

Á Input 

Ğ Command Byte: 0x35 

Ğ Data Bytes: N/A 

Á Output: N/A ï this command is not acknowledged 
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B.2.3  Exit  Bootloader  

Exits from the bootloader. Ends the bootload operation. 

Á Input 

Ğ Command Byte: 0x3B 

Ğ Data Bytes: N/A 

Á Output: N/A ï This command is not acknowledged 

B.2.4  Send Data  

Transfers a block of data to the bootloader. This data is buffered in anticipation of a Program Data or Verify Data 
command. If a sequence of multiple send data commands are sent, the data is appended to the previous block. This 
command is used to break up large data transfers into smaller pieces, to prevent channel starvation in some 
communication protocols. 

Á Input 

Ğ Command Byte: 0x37 

Ğ Data Bytes: 

Á n bytes: Data to write or verify 

Á Output 

Ğ Status/Error Codes: 

Á Success 

Á Error Command 

Á Error Data 

Á Error Length 

Á Error Checksum 

Ğ Data Bytes: N/A 

B.2.5  Send Data Wi thout  Response  

Same as the Send Data command, except that no response is generated by the bootloader. This reduces bootload 
time for some applications. 

Á Input 

Ğ Command Byte: 0x47 

Ğ Data Bytes: 

Á n bytes: Data to write or verify 

Á Output: N/A 
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B.2.6  Program Data  

Writes data to one row of the device internal flash or page of external non-volatile memory (NVM). May follow a 
series of Send Data or Send Data Without Response commands. 

Á Input 

Ğ Command Byte: 0x49 

Ğ Data Bytes: 

Á 4 bytes: Address. Must be within the correct memory address space, and appropriately aligned. For 
internal flash, it must be aligned to a flash row boundary. For external memory, it must conform to external 
memory alignment requirements. 

Á 4 bytes: CRC-32C of the entire data to be written. The data is verified both before and after programming. 

Á n bytes: Data to write into the flash row or external NVM page. 

Á Output 

Ğ Status/Error Codes: 

Á Success 

Á Error Command 

Á Error Data 

Á Error Length 

Á Error Checksum 

Á Error Flash Row 

Á Error Flash Row Access 

Ğ Data Bytes: N/A 

B.2.7  Veri fy Data  

Compares data to one row of the device internal flash or page of SMIF. May follow a series of Send Data or Send 
Data Without Response commands. 

This command is optional; its presence depends on a user configuration macro in bootload_user.h. 

Á Input 

Ğ Command Byte: 0x4A 

Ğ Data Bytes: 

Á 4 bytes: Address. Must be within the correct memory address space, and appropriately aligned. For 
internal flash, it must be aligned to a flash row boundary. For external memory, it must conform to external 
memory alignment requirements. 

Á 4 bytes: CRC-32C of the entire data to be verified. 

Á n bytes: Data to compare with the flash row or SMIF page. 

Á Output 

Ğ Status/Error Codes: 

Á Success 

Á Error Verify 

Á Error Command 

Á Error Data 

Á Error Length 

Á Error Checksum 

Á Error Flash Row 

Á Error Flash Row Access 

Ğ Data Bytes: N/A 

Á Implementation details 

Ğ The command returns the ñSuccessò status code if all data bytes match the bytes starting at the specified 
flash address, otherwise ñError Verifyò. 
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B.2.8  Erase Data  

Erases the contents of the specified internal flash row or SMIF page. 

This command is optional; its presence depends on a user configuration macro in bootload_user.h. 

Á Input 

Ğ Command Byte: 0x44 

Ğ Data Bytes: 

Á 4 bytes: Address. Must be within the correct memory address space, and appropriately aligned. For 
internal flash, it must be aligned to a flash row boundary. For external memory, it must conform to external 
memory alignment requirements. 

Á Output 

Ğ Status/Error Codes: 

Á Success 

Á Error Command 

Á Error Data 

Á Error Length 

Á Error Checksum 

Á Error Flash Row 

Á Error Flash Row Access 

Ğ Data Bytes: N/A 

B.2.9  Veri fy Appl icat ion  

Reports whether the checksum for the application in flash or external NVM is valid. 

Á Input 

Ğ Command Byte: 0x31 

Ğ Data Bytes: 

Á 1 byte: Application number of the application to be verified. May range from 0 to the number of 
applications minus one. 

Á Output 

Ğ Status/Error Codes: 

Á Success 

Á Error Command 

Á Error Data 

Á Error Length 

Á Error Checksum 

Á Error Flash Row Access 

Ğ Data Bytes: 

Á 1 byte: 1/0 for application is valid or not valid 
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B.2.10  Set Appl icat ion Metadata  

This command is used to set a given applicationôs metadata. See Appendix D, Application Metadata. 

Note: This command does not update the metadata if the user configures the Bootloader SDK to keep the metadata 
unchanged. 

Á Input 

Ğ Command Byte: 0x4C 

Ğ Data Bytes: 

Á 1 byte: Application # 

Á 8 bytes: metadata field format per Appendix D 

Á Output 

Ğ Status/Error Codes: 

Á Success 

Á Error Command 

Á Error Length 

Á Error Data 

Á Error Checksum 

Á Error Flash Row Access 

Ğ Data Bytes: N/A 

B.2.11  Get Metadata  

Reports selected metadata bytes. 

This command is optional; its presence depends on a user configuration macro in bootload_user.h. 

Á Input 

Ğ Command Byte: 0x3C 

Ğ Data Bytes: 

Á 2 bytes: from offset within row; 0 ï 511 

Á 2 bytes: to offset within row; 0 ï 511 (inclusive) 

Á Output 

Ğ Status/Error Codes: 

Á Success 

Á Error Command 

Á Error Length 

Á Error Data 

Á Error Checksum 

Á Error Flash Row Access 

Ğ Data Bytes: 

Á N bytes ï per from and to offset bytes (inclusive) 
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B.2.12  Set EIVector  

Sets an encryption initialization vector (EIV). This enables the bootloader to decrypt data before writing it to flash. 

This command is optional; its presence depends on a user configuration macro in bootload_user.h. 

Á Input 

Ğ Command Byte: 0x4D 

Ğ Data Bytes: 

Á n bytes: the vector; 0, 8, or 16 bytes, little-endian raw data 

Á Output 

Ğ Status/Error Codes: 

Á Success 

Á Error Command 

Á Error Length 

Á Error Data 

Á Error Checksum 

Ğ Data Bytes: N/A 
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Appendix C. .cyacd2 File Format 

The .cyacd2 file contains downloadable application data. It is created by CyMCUElfTool, and used by host programs 

such as Cypressô Bootloader Host Program and CySmart to send applications to the target bootloader, as Figure 5 on 
page 6 shows. The file data is in the form of ASCII hex numbers, similar to Intel hex format. Each byte of data is 
represented by two characters. For example, a byte 0x1E is represented by the characters 0x31 (ASCII ó1ô) followed 
0x45 (ASCII óEô). 

All multi-byte fields are little-endian. 

The file consists of a series of lines, or rows. Each row is terminated with ASCII CR, LF characters. A row is one of 
the following types: 

Á Encryption initial vector: An encryption initial vector row is of the format @EIV:<bytes> . The data in <bytes> is 

used by the host program in the SetEIV command to the bootloader. 

Á Application verification information: An application verification information row is of the format: 

@APPINFO:[__cy_app_verify_start],[__cy_app_verify_length] . 

The start and length data are used by the host program in the Set Application Metadata command to the 
bootloader. 

Á Header: A header row has the structure shown in Figure 29: 

Figure 29. .cyacd2 Header Row Structure 

File Version Silicon ID Silicon Revision Checksum Type App ID Product ID 

1 byte 4 bytes 1 byte 1 byte 1 byte 4 Bytes 

 

Ğ File Version: Numbered starting at 1. 

Ğ Silicon ID, Silicon Revision, Product ID: Used to prevent the application from being downloaded to the wrong 
device. 

Ğ Checksum Type: The method used to verify a bootloader packet (see Appendix B, Command / Response 
Packet Structure). 0 = checksum, 1 = CRC. 

Ğ App ID: See Figure 6 on page 7. This also controls which portion of the application metadata is updated for 
this application. 

Á Data: A data row has the structure shown in Figure 30. 

The value of N equals the total amount of data to be sent 
with a series of Send Data or Send Data Without 
Response commands followed by a Program Data or 
Verify Data command. 

The value of N typically, but not necessarily, equals the 
length of an NVM row. For example, if bootloading into 
RAM, then N may be an arbitrary value. 

Figure 30. .cyacd2 Data Row Structure 

Header Address Data 

1 character: ñ: ò 4 bytes N bytes 
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Appendix D. Application Metadata 

The Bootloader SDK uses a designated region of NVM (or RAM in some cases) to store information about the 
applications ï see Figure 6 on page 7. Metadata information is generally used for the following purposes: 

Á Validate an application 

Á Transfer control from one application to another 

Á Copy an application image from a temporary location to its designated location 

As noted in Figure 6, metadata typically occupies one flash row or NVM page. (In devices with small amounts of 
flash, multiple rows or pages may be used.) Figure 6 also shows that metadata is located outside of any application. 

Table 8 contains symbols that are used to define the location, size and usage of the bootloader metadata. The 
symbols are defined in the SDK linker script files and C source files. 

Note: All examples shown are for the GCC compiler and linker. Similar statements exist in source and linker script 
files for the MDK and IAR compilers and linkers. 

Table 8. Metadata-Related Symbols 

Symbol Defined In Purpose 

flash_boot_meta  bootload_common.ld Defines the physical memory region that contains the 
metadata 

Example Usage: flash_boot_meta  (rw) : ORIGIN = 0x100FFA00, LENGTH = 0x400  

Defines a region in the last 1 KB of the 1-MB PSoC 6 MCU user flash (which starts at 0x1000 0000). 

 

__cy_boot_metadata_addr  
__cy_boot_metadata_length  

bootload_common.ld These symbols define a compiler-independent memory 
address range that is used to store the metadata. These 
symbols are used in the Bootloader SDK code and may be 
used in user code. 

Example Usage: /* Bootloader SDK metadata limits */  
/* Note that __cy_memory_0_row_size equals the row length in bytes of  
   PSoC 6 user flash. */  
__cy_boot_metadata_addr = ORIGIN(flash_boot_meta);  
__cy_boot_metadata_length = __cy_memory_0_row_size;  

 

.cy_boot_metadata  bootload_cm0p.ld 
bootload_cm4.ld 

The bootloader metadata is stored in this section. At build 
time, CyMCUElfTool calculates the checksum of this section 
and places it in the last four bytes of the section. When a 
checksum is not needed, rename the section to any other 
name. 

Example Usage: .cy_boot_metadata :  
{  
    KEEP(*(.cy_boot_metadata))  
} > flash_boot_meta  

 

CY_BOOTLOAD_MAX_APPS bootload_user.h Allows the user to control the maximum number of 
applications supported in the bootloader metadata 

Example Usage: /* The smallest metadata size is CY_BOOTLOAD_MAX_APPS * 8 bytes per app +  
   an optional 4 bytes for metadata checksum */  
#define  CY_BOOTLOAD_MAX_APPS  (2u) 
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Symbol Defined In Purpose 

CY_BOOTLOAD_METADATA_WRITABLE bootload_user.h The bootloader does not necessarily write metadata ï it can 
be done by the application or some other user code. Or 
metadata may be set using a compile-time constant within 
an application. An application can have metadata that is  
smaller than an NVM row. 
In all these cases, set this macro to 0 to prevent the 
bootloader from writing metadata. 
However, note that the bootloader requires that a metadata 
region exist and be properly initialized. This may be done by 
the bootloader itself, or by an application. 

Example Usage: /* A non - zero value allows writing metadata  with the SetAppMetadata command. */  
#define  CY_BOOTLOAD_METADATA_WRITABLE  (1) 

 

D.1 Metadata Structure 

Application metadata has eight bytes of data per application, followed by four bytes for checksum, as Figure 31 
shows: 

Figure 31. Metadata Structure 

Application 0 Application 1 

. . . 

Application N ï 1 Checksum 

8 bytes 8 bytes 8 bytes 4 bytes 

 

Application Start Address Application Length (bytes) 

4 bytes 4 bytes 

 

You can set the number of applications N in the bootload_user.h file: 

#define  BOOTLOAD_MAX_APPLICATIONS (N) 

The default value of N is 2. 

Each application start address must be aligned to a flash row or NVM page boundary. The application length must be 
a multiple of the flash row or NVM page length. 

The Checksum is calculated with the same algorithm that is used in the bootloader commands Program Data and 
Verify Data. The default algorithm is CRC-32C. 
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Appendix E. Post-Build Batch File Listing 

The following is a listing of the post-build batch file for App1, from CE213903. The batch file is similar if not the same 
in the other code examples. The same batch can be used with multiple downloadable applications, for example app2 
in the dual-application bootloader. 

@rem Usage:  

@rem Call post_build_core1.bat <tool> <output_dir> <project_short_name>  

@rem E.g. in PSoC Creator 4.2:  

@rem      post_build_core1.bat creator ${OutputDir} ${ProjectShortName}  

 

@echo ------------------------------------------  

@echo   Post - build commands  for Cortex - M4 core  

@echo ------------------------------------------  

 

@rem Set proper path to your PDL 3.x and above installation  

@set PDL_PATH="C: \ Program Files (x86) \ Cypress \ PDL\ 3.0.1"  

 

@set CY_MCU_ELF_TOOL=%PDL_PATH%"\ tools \ win \ elf \ cymcuelftool.exe"  

 

@set IDE=%1  

 

@if "%IDE%" == "creator" (  

    @set OUTPUT_DIR=%2 

    @set PRJ_NAME=%3 

    @set ELF_EXT=.elf  

)  

 

@if "%IDE%" == "uvision" (  

    @set OUTPUT_DIR=%2 

    @set PRJ_NAME=%3 

    @set ELF_EXT=.axf  

)  

 

@if "%IDE%" == "iar" (  

    @set OUTPUT_DIR=%2 

    @set PRJ_NAME=%3 

    @set ELF_EXT=.out  

)  

 

@if "%IDE%" == "eclipse" (  

    @set OUTPUT_DIR=%2 

    @set PRJ_NAME=%3 

    @set ELF_EXT=  

)  

 

%CY_MCU_ELF_TOOL% - S %OUTPUT_DIR%\ %PRJ_NAME%%ELF_EXT% CRC 

%CY_MCU_ELF_TOOL% - P %OUTPUT_DIR%\ %PRJ_NAME%%ELF_EXT% -- output %OUTPUT_DIR%\ %PRJ_NAME%.cyacd2 

http://www.cypress.com/
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